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Abstract

This study aims to design a Building Automation System that can control
electrical devices that are carried out remotely at the same location or via WiFi
and Web Server applications, to make it easier for people to control devices
located in distant buildings without direct contact and can be accessed. anywhere
within range of the local network. The research method used is research and
development methods, namely by conducting literature studies and interviews
with electrical and arduino experts. The results of the research are a system made
using the ESP8266 WiFi module which is set as a station, which connects
Arduino to the local internet which will be controlled by the Web Sever
application from anywhere with local internet connection range. The Building
Automation System that is made can switch Hologen lamps and incandescent
lamps and is set using the blynk application that is connected to an internet
connection.

Keywords: arduino, building automation, internet

Abstrak

Penelitian ini bertujuan untuk merancang Building Automation System yang
dapat mengontrol perangkat listrik gedung dilakukan secara remote pada lokasi
yang sama maupun melalui WiFi dan aplikasi Web Server, untuk memberikan
kemudahan untuk orang-orang mengontrol perangkat listrik yang berada di
gedung dari jarak jauh tanpa adanya kontak langsung dan dapat diakses dimana
saja dalam jangkaun jaringan lokal. Metode penelitian yang digunakan adalah
metode research and development yaitu dengan melakukan studi pustaka dan
wawancara dengan pakar kelistrikan dan arduino. Hasil penelitian berupa sistem
yang dibuat menggunakan modul WiFi ESP8266 yang disetting sebagai station,
yang menghubungkan Arduino dengan internet lokal yang akan dikontrol oleh
aplikasi Web Sever dari mana saja dengan jangkauan koneksi internet lokal.
Building Automation System yang dibuat dapat mensaklar lampu Hologen dan
lampu pijar dan diatur menggunakan aplikasi blynk yang terhubung dengan
koneksi internet.

Kata Kunci: arduino, otomatisasi gedung, internet
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A. PENDAHULUAN

Perkembangan teknologi yang pesat bisa
dimanfaatkan dari adanya koneksi internet
ini adalah bisa mengakses peralatan
elektronik seperti lampu ruangan yang dapat
dioperasikan dengan cara online melalui
website. Sehingga dapat memudahkan
pengguna memantau ataupun
mengendalikan lampu  kapanpun dan
dimanapun dengan catatan di lokasi yang
akan diterapkan teknologi kendali jarak jauh
masih mencakup jaringan internet local kita.
Sistem  kendali  jarakjauh, memudah
kanpengguna dalam mengontrol lampu
gedung yang jaraknya cukup jauh lokasinya.

IoT (Internet of Things) merupakan
suatu  konsep yang bertujuan untuk
memperluas manfaat dari  konektivitas
sistem berbasis internet yang tersambung
secara terus menerus.

Arduino adalah salah satu komponen
IoT (Internet of Things) yang dapat
diaplikasikan sebagai pengendalian jarak
jauh dengan jaringan internet yang dapat
diterapkan pada peralatan elektronik sepert
ilampu. Perangkat tersebut dapat diakses
dengan layanan berbasis internet melalui
website dengan Transmission Control
Protocol  Internet  Protocol  (TCP/IP)
sehingga bias menghilangkan kebutuhan
berada dilokasi untuk mengaktif kanmaupun
me-non-aktifkan perangkat tersebut.

Teknologi sistem kendali ini diperlukan
dengan meninjau segala aspek baik dari
tingkat efisiensi tenaga dan waktu jam kerja
petugas serta dari segi penghematan energi
listrik yang digunakan.

Dengan memanfaatkan koneksi internet
yang dipadukan dengan arduino UNO dan
ethernet shield diharapkan dapat melakukan
kendali terhadap peralatan elektronik yang
terdapat pada gedung instansi pemerintahan,
instansi pendidikan maupun pada rumah
tangga bahkan jika dikembangkan lebih jauh
bisa dijadikan sebagai pendukung smart city

yang saat ini sedang dicanangkan oleh
beberapa daerah di negara Indonesia.

Pemanfaatan IoT berbasis Arduino
dalam pengontrolan lampu menggunakan
android (Warangkiran, Kaunang, Lumenta,
& Rumagit, 2014) untuk mengendalikan,
mengaktifkan atau menonaktifkan, setelah
itu dihubungkan dengan jaringan lokal
wireless yang ada di wizfi. Wizfi dan
mikrokontroler di setting melalui PC/Laptop
agar dapat berhubungan dengan smartphone
android melalui jaringan local wireless, dan
juga bisa berhubungan dengan rangkaian
relay untuk mengendalikan, menyalakan /
mematikan perangkat listrik berupa lampu.
Perangkat  wireless wizfi 210 dan
mikrokontroler arduino uno, hasil penelitian
ini didapat bahwa perangkat ini dapat
digunakan untuk mengontrol, mengaktifkan
dan menonaktifkan perangkat lampu.

Pengiriman data dari mikrokontroler
menuju komputer server dapat dilakukan
secara  wireless ~menggunakan modul
ESP8266 (Yuliansyah, 2016). Menerapkan
tiga metode yaitu dengan menggunakan AT-
Command, Protokol SLIP dan NodeMCU.
Pengujian dilakukan dengan cara
mengirimkan data secara sistematis menuju
komputer server. Kecepatan transfer data
maksimum dicapai dengan menggunakan
metode ATCommand 31200 data per menit.
Namun jika ditambahkan komponen jumlah
data terkirim metode SLIP meraih kecepatan
tertinggi sebesar 15000 data per menit.
Metode NodeMCU hanya mampu mengirim
data dengan kecepatan maksimum 5271 data
per menit.

B. METODE PENELITIAN

Metode — metode yang dilakukan dalam
melakukan penelitian ini adalah sebagai
berikut:

1. Studi Pendahuluan

Menentukan tujuan dan batasan masalah

dengan melihat faktor-faktor dan sistem




lain yang bermanfaat bagi
pengembangan sistem pada penelitian
ini.

. Wawancara

Dengan metode ini penulis melakukan
wawancara atau  konsultasi  secara
langsung dengan komunitas penghobi
Arduino  sering  tukar  pendapat
perkembangan tehnolagi sekarang dan
akan dating untuk memperoleh data —

data  yang  berhubungan  dengan
pemrograman bahasa C++ khususnya
yang menyangkut masalah
perkembangan Arduino

Studi Kepustakaan

Studi literature dan referensi, yaitu
mempelajari  buku-buku dan  juga
makalah-makalah yang terkait dengan
topik yang dibahas, untuk kemudian
dijadikan sebagai acuan dan referensi
dalam  merancang dan  membuat
penelitian ini.

. Membuat perancangan sistem yang

terdiri dari dua bagian, yaitu:

a. Perangkat Keras (Hardware)
Meliputi penghubungan  Arduino
dengan modul Bluetooth serta
pengendalian saklar pada prototipe
rumah cerdas.

b. Perangkat Lunak (Software)

Meliputi pembuatan program untuk
Note  Mcuesp 8266  dengan
menggunakan  program  Arduino
1.0.1

Setelah sistem dirancang, selanjutnya
direalisasikan secara keseluruhan yang
meliputi beberapa bagian, yaitu bagian
pengirimin  struksi  data, penerima
instruksi data dan diarea Gedung Cerdas.
Sistem yang telah dibuat, di uji coba dan
dianalisa  dengan  mengintegrasikan
semua bagian secara keseluruhan, untuk
memastikan bahwa sistem telah dapat
bekerja dengan baik dan hasilnya sesuai
dengan yang diinginkan.

C. HASIL DAN PEMBAHASAN

Perancangan dan Pembuatan Alat

Objek pada penelitian ini adalah aplikasi
prototipe dengan menggunakan
mikrokotroler Arduino uno ESP8266
dengan berbasis WIFI WEB Selver lokal
untuk mengontrol lampu jarak disekitar
rumah.

ROUTER
HOTSPOT

LAMP

RANGHKAIAN
I l Wiki Router

CLIENT
(WEB

Fle
1l

o i
Ll
20l wp il

L3

il
CHI

U B

L ESP8266 Module Relay Eoard
Android Device

Gambar 1. Diagram Alir Pengerjaan Alat

Diagram Blok Sistem

Dalam perancangan dan pembuatan alat
untuk pengontrol lampu gedung diperlukan
suatu sistem yang dapat memonitoring
lampu pada saat keadaan mati atau hidup.
Pembuatan alat dibedakan dalam beberapa
blok fungsi gambaran umum mengenai
sistem kerja dan pembagian blok sistem dari
penelitian ini ditunjukkan pada gambar 2.
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Gambar 2. Diagram Blok Sistem

Perancangan Perangkat Keras

Perancangan dan pembuatan perangkat
keras meliputi flowchart prinsip kerja alat
untuk sistem kendali jarak jauh on/off lampu
berbasis arduino UNO. Perancangan
perangkat keras sendiri terdiri dari
pembuatan rangkaian secara schematic baik
dari, rangkaian Arduino UNO dengan
Ethernet Shield serta rangkaian relay untuk
kontrol lampu. Berikut ini

Cek Koneksi Kabel LAN
dan Uji Coba Respon IP
Ethernet

]

Masuk Web Browser lalu
Uji Fitur Kendali Satu
Lampu dan Seluruh
I amm

Apakah Fitur
Kendali Lampu
Berjalan ?

:

Gambar 3. Flowchart sistem

Sebelum membangun rangkaian
sesungguhnya, digunakan software bantu
yang difungsikan untuk menggambarkan
rangkaian  secara  skematik  terhadap
rangkaian yang akan dibangun nantinya,
baik itu rangkaian Arduino UNO dan
ESP8266, rangkaian relay dan rangkaian
keseluruhan untuk membangun rangkaian
IoT (Internet of Things).

Perancangan Arduino UNO dan ESP8266

Seperti yang diketahui bahwa pada
Arduino UNO memiliki 14 pin Input Output
(/0) digital dimana 6 pin sebagai input
Analog, 6 pin sebagai input Analog, 1 pin
untuk Rx-Tx (Receiver/Transmitter) dan 1
pin untuk AREF (Analogue Reference). Pin
analog digunakan untuk masukan tegangan
analog dan juga dapat mengenali sinyal
pada rentang nilai voltase tegangan yang
masuk, selain itu pada pin analog terdapat
fitur yang dapat mengubah sinyal analog
yang masuk menjadi nilai digital yang
mudah dibaca. Berbeda dengan Pin digital
yang terdapat pada arduino, pin digital
hanya dapat mengenali sinyal 0 Volt sebagai
nilai LOW dan 5 Volt sebagai nilai HIGH.
ESP8266 adalah wifi module dengan output
serial TTL yang dilengkapi dengan GPIO,
wifi module ini dapat dipergunakan secara
standalone maupun dengan mikrokontroler
tambahan untuk kendalinya.

Tegangan kerja ESP-8266 adalah
sebesar 3.3V, sehingga untuk penggunaan
mikrokontroler tambahannya dapat
menggunakan board arduino yang memiliki
fasilitas tengangan sumber 3.3V, akan
tetapi akan lebih baik jika membuat secara
terpisah level shifter untuk komunikasi dan
sumber tegangan untuk wifi module ini

Karena wifi module ini dilengkapi
dengan Mikrokontroler dan GPIO sehingga
banyak orang yang mengembangkan
firmware untuk dapat mengunakan module
ini tanpa  perangkat  mikrokontroler
tambahan. Firmware yang digunakan agar




wifi module ini dapat bekerja standalone
adalah Node MCU.

Selain dengan Node MCU dapat
menggunakan module ini dengan Arduino
maupun mikrokontroler lainnya untuk
menjaga kestabilan komunikasinya.
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Gambar 4. Rangkaian ESP8266

Rangkaian Relay Untuk Kontrol Lampu

Pengontrolan on/off lampu dapat
dilakukan dari jarak jauh dengan mengakses
internet.  Jadi, rangkaian relay akan
dihubungkan ke arduino UNO pada pin
yang sudah ditentukan. Relay akan bekerja
apabila memperoleh input logika High dari
arduino. Untuk rangkaian relay pengontrol
lampu dapat dilihat pada gambar 3.4

OLED ESP8266 Module

Gambar 5. Rangkaian Relay kontrol
lampu

Rangkaian
Keseluruhan

Rancang bangun alat yang telah dibuat
secara skematik satu persatu, selanjutnya
digabungkan menjadi satu rangkaian besar
dengan menarik garis kabel pemakaian kaki
pin pada arduino dimana kaki pin
digunakan untuk menghubungkan ESP 8266
dengan arduino, kaki pin digunakan untuk
rangkaian relay yang berfungsi untuk saklar
on/off. Berikut dibawah ini rangkaian
keseluruhan rancang bangun yang akan
dibuat.
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Gambar 6. Rancang Bangun Keseluruhan

Perancangan Software Arduino Webserver

Pada bagian ini perancangan bahasa
pemrograman menggunakan Arduino IDE
yang merupakan software downloader untuk
Arduino UNO, program Arduino IDE ini
yang menjadi interface antara hardware dan
software.  Rancangan  software yang
nantinya dibangun terdapat dua fitur
software kendali yaitu kendali satu lampu
dan kendali seluruh lampu yang ada pada
sebuah ruangan.

Agar purwa rupa IoT (Internet of
Things) dapat diakses dari jaringan
diperlukan suatu identitas atau yang dikenal
dengan istilah IP Address agar dapat saling
terhubung satu sama lain, baik itu antara
komputer klien sebagai pengakses dengan
alat yang dibangun. Pada program Arduino
UNO yang dibangun, diberikan IP Address
192.168.43.178 yang dapat diakses melalui
web browser.
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Arduino Web Server bertindak sebagai
sebuah embedded web server, yang
menyimpan halaman web sederhana yang
menampilkan  status  peralatan  yang
terhubung dengan rangkaian relay yang
berfungsi sebagai saklar on/off lampu.
Halaman web pada alat IoT (Internet of
Things) ini  dibuat dengan bahasa
pemrograman HTML yang di embedded
(ditanamkan) kedalam Arduino UNO.

Pengujian

Pada tahap ini proses pengujian yang
pertama dilakukan terhadap alat yang telah
dirangkai yaitu rangkaian relay, rangkaian
arduino UNO dan ESP8266, pengujian yang
kedua dilakukan terhadap fitur software
yang telah dibuat.

Pada saat uji coba dilakukan, terdapat
skenario yang dibuat yaitu dengan
melepaskan kabel USB (Universal Serial
Bus) yang difungsikan sebagai penghubung
catu daya dengan arduino UNO, hal ini
diasumsikan bahwa pada saat pemasangan
alat kendali TIoT (Internet of Things) pada
gedung nantinya terdapat kondisi suatu
waktu terjadi pemadaman listrik dari PLN.
Yang terjadi pada alat yang dibuat adalah
posisi pembacaan kondisi terakhir atau last
state tidak dalam kondisi terakhir sesaat
sebelum terjadinya pemadaman listrik, hal
ini dikarenakan rangkaian Arduino UNO
mengalami kondisi reset by self dan tidak
bisa melakukan pembacaan terakhir
sebelum terjadinya pemadaman, sehingga
hal yang terjadi adalah seluruh peralatan
listrik yang dikendalikan dalam kondisi off.

Perancangan perangkat keras
(Hardware)

1. Alat dan bahan

ESP8266 Note Mcu

Piting lampu

Kabel

Project board

Relay 16 channel

Fuse

Saklar

NN NN

v' Lampu
v Papan

(3 Buah)

v Box Panel
v' Power supply 5V / 12V

Susun rangkaian sesuai dengan wairing

diagram berikut ini.

MODUL RELAY 16 CHANEL

@ GND 10 GND
@ VCC to VWIS Vush
@ i topin D5
@ Iri2 to pn D6
@ in3 50 pin O7
@ Ind o pn DB

ESP8266 Nodemcu

Gambar 7. Wairing Diagram

Susun rangkaian pada kotak seperti
gambar dibawah ini

BEES————

ambar 8. Kotak Rangkaian
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4. Pasang piting lampu pada papan dan
Box komponennya

Gambar 9. Pemasangan Komponen Pada
Box

5. Rapikan kabel lalu beri label pada
rangkaian

Gambar 10. Prototype kontrol gedung

Modul ESP8266 Note MCU

ESP8266 merupakan modul wifi yang
berfungsi sebagai perangkat tambahan
mikrokontroler seperti Arduino agar dapat

terhubung langsung dengan wifi dan
membuat koneksi TCP/IP.

Modul ini membutuhkan daya sekitar
3.3v dengan memiliki tiga mode wifi yaitu
Station, Access Point dan Both (Keduanya).
Modul ini juga dilengkapi dengan prosesor,
memori dan GPIO dimana jumlah pin
bergantung dengan jenis ESP8266 yang kita
gunakan. Sehingga modul ini bisa berdiri
sendiri tanpa menggunakan mikrokontroler
apapun karena sudah memiliki perlengkapan
layaknya mikrokontroler.

Firmware default yang digunakan oleh
perangkat ini menggunakan AT Command,
selain itu ada beberapa Firmware SDK yang
digunakan oleh perangkat ini berbasis
opensource yang diantaranya adalah sebagai
berikut :

1. NodeMCU dengan menggunakan basic
programming lua

2. MicroPython dengan menggunakan
basic programming python

3. AT Command dengan menggunakan
perintah perintah AT command

Untuk pemrogramannya sendiri kita bisa
menggunakan ESPlorer untuk Firmware
berbasis NodeMCU dan menggunakan putty
sebagai terminal control untuk AT
Command.

Selain itu kita bisa memprogram
perangkat ini menggunakan Arduino IDE.
Dengan menambahkan library ESP8266
pada board manager kita dapat dengan
mudah memprogram dengan basic program
arduino.

Rangkaian Relay

Relay adalah Saklar (Switch) yang
dioperasikan secara listrik dan merupakan
komponen Electromechanical
(Elektromekanikal) yang terdiri dari 2
bagian utama yakni Elektromagnet (Coil)
dan  Mekanikal (seperangkat Kontak
Saklar/Switch). Relay menggunakan Prinsip
Elektromagnetik  untuk  menggerakkan
Kontak Saklar sehingga dengan arus listrik
yang  kecil  (low  power)  dapat
menghantarkan listrik yang bertegangan
lebih tinggi. Sebagai contoh, dengan Relay
yang menggunakan Elektromagnet 5V dan
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50 mA mampu menggerakan Armature
Relay (yang berfungsi sebagai saklarnya)
untuk menghantarkan listrik 220V 2A.

Perancangan Perangkat Lunak (software)

Perancangan perangkat Iunak atau
software ialah pembuatan aplikasi yang
merupakan suatu project yang menjadi salah
satu hal penting untuk melengkapi
pembuatan smarthome ini. Dengan adanya
aplikasi yang akan di buat memudahkan
pengguna untuk mengendalikan suatu
ruangan. dengan salah satu contoh
menghidupkan atau mematikan lampu lebih
dari satu ruangan. sesuai dengan aplikasi
yang buat. Dengan begitu pengguna akan
lebih mudah mengaplikasikannya dalam hal
ini penulis membuat web server Berikut
cara pembuatan software yang akan di buat :
Langkah ke 1 : Buka Arduino IDE dan
masuk ke Menu File -> Preferences
Langkah ke 2 : Masukan LINK berikut ke
dalam kotak "Additional Boards Manager
URLs"
http://arduino.esp8266.com/stable/package
esp8266com_index.json

kemudian OK

Gambar 11. Preferences pada apalikasi
Arduino IDE

Langkah ke 3 : Masuk Menu Tools -> Board
-> Board Managers

Pada jendela Board Manager cari board
ESP8266  (biasanya  paling  bawah)
kemudian tekan INSTALL . Tunggu hingga

proses download dan install selesai. Jika
sudah selesai akan  muncul  text
INSTALLED, berwarna hijau di samping
nama board.

/% Boards Manage

| AMEL-Tech Boards by replaced by Arrow Soards verzion 1.1.0 INSTALLED
in this package

MOD-WIFI-ESPB265(-DEV), NodeMCU 0.9 (ESP-12 Module), NodeMCU 1.0 {ESP-12E Madule),
210, WaMos D1,

arkFun Thing, SwostPaa ESP-210, WaM WaMos

Remove

Gambar 12. Board manager pada Arduino
IDE

Langkah ke 4 : Colok Board ESP8266 ke
USB.

Langkah ke 5 : .Kembali ke Menu Tools ->
Board kemudian pilih Board ESP8266
Sesuai Jenis ESP Board anda dan pilih
COM port sesuai port chip Uploader yang
terdeteksi pada Device Manager Windows.
Pada kali ini saya Menggunakan
Board "Adafruir HUZZAH ESP8266"

/9 Blink | Arduino 16.7 @ Q

File Edit Sketch Tools Help
oo ] Auto Format CerlsT [o]
Archive Sketch
Blink Fix Encoding & Reload [~

Serial Monitor Ceri+Shift+M

Serial Plotter Ctri+Shift+L

Board: "Adafruit HUZZAH ESPB266"
CPU Frequency: "80 MHz"

Flash Size: "4M (3M SPIFFS)"
Upload Speed: "115200"

Port: "COM30"

Programmer: "AVRISP mkil"

Burn Bootloader

Gambar 13. pemilihan Board Esp Note
Mcu8266

MHz, 115200, 4M (3M SPIFFS) on COM3D
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Langkah ke 6 lalu Board ESP8266
NodeMcu siap diprogram menggunakan
Arduino IDE. Pada saat melakukan
pemrograman  ESP8266  menggunakan
Arduino IDE yang kita pakai sebagai acuan
adalah nomor GPIO dari ESP nya,bukan
nama pin pada Board nya sehingga kita
membutuhkan GPIO Pin Maping seperti
pada gambar dibawah ini :

Gambar 14. GPIO Maping ESP8266
Nodemcu pada Arduino IDE

Artinya apabila kita ingin menggunakan Pin
DO pada board maka kita harus menuliskan
nomor GPIO nya,yaitu '16' saat membuat
coding pada  Arduino  IDE.Berikut
contohnya :

Gambat 15. kodingan GPIO

Untuk memudahkan kita membuat coding
dengan Arduino IDE perhatikan tabel GPIO
maping berikut :

ESP8266 Nodemcu GPIO Maping

10 Number | Pin Mame Pin Name | 10 Number
GPIOD D3 DO
GPIO1 D10 D1
GPIO2 D4 D2
GPIO3 D9 D3
GPIO 4 D2 D4
GPIO S D1 D5
GPIOS sD2 D6
GPIO 10 sD3 D7
GPIO 12 D6 D&
GPIO 13 D7 D9
GPIO 14 D5 D10
GPIO 15 D& sD2
GPIO 16 Do SD3
Gambar 16. Merubah Tampilan Pada
Aplikasi

Langkah ke 7: Lalu Upload Sketch Coding

Dari hasil penelitian yang di lakukan,
peneliti melakukan pengujian
menghidupkan atau mematikan lampu dan
mendapatkan hasil yaitu lampu bisa di
control oleh client/user. Lampu dapat
hidu/mati dengan cara di control oleh
browser client/user dan di tampilan web
server yaitu halaman control memiliki
keterangan bahwa mati atau hidupnya lampu
yang sudah di jalankan

Gambar 17. Pengujian tombol Web server
dan prototype Kontrol Lampu Gedung
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Dari pengujian jarak yang dilakukan kita

Ceiieso— “dapat mengabil hasil kalau Module

Bluetooth HC-06 dapat Terkoneksi dan
mengirim data dengan baik dengan jarak
makasimal 9 meter dan apabila di atas 10

1 Meter koneksi akan terputus dan dan tidak
dapat mengirimkan data.

Sistem perangkat lunak pada handphone
Sistem yang digunakan pada handphone
untuk mengoprasikan smarthome ini dengan
mengakt1ﬂ<an aplikasi yang sudah di buat.
mengaktifkan ~ Bluetooth  untuk
terkoneksi pada prototype pengotrolan
gedung yang sudah di buat, dengan begitu

TR “Bluetooth sudah terkoneksi atau terhubung

satu sama lain dengan dengan prototype
penontrolan gedung yang dapat
dimonitoring pada aplikasi

Untuk perangkat lunak pada handphone
ialah hanya aplikasi dan Bluetooth / Wifi
sebagai koneksi antara handphone android
dan prototype gedung pengotrolan yang di
buat.

‘%_._rnD PENUTUP
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se 94 aeswamew = Berdasarkan dari hasil perancangan dan

pengujian dapat ditarik kesimpulan bahwa

1. Aplikasi yang dibangun telah
dapat pengotrolan dengan baik dan
mudah, sehingga dapat membantu
pemilik rumah

2. Aplikasi yang dibangun telah dapat
memantau (monitoring) keadaan kondisi
lampu gedung dan perangkat lainnya
dengan jarak jauh

3. Aplikasi  yang dibangun telah
dapat dikembangkan di modifikasi
seperti [P Camera. Sensor keamanan.
Kunci gedung dan lainya.

| Untuk pengembangan dan perbaikan

kedepannya disarankan untuk:

Gambar 18. Keterangan Mati/Hidupnya 1. Untuk pengembangan kedepan dapat

Lampu Pada Web Browser

menjangkau area yang lebih luas, dapat
mencakup keamanan gedung tersebut
lewat SMS, Email, Alarm.
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2. Dapat pula di perbanyak dengan
setandart produksi. Masih punya nilai
purna jual tinngi dikarnakan cukup
ekonomis dan murah dan portable.
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